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Introduction


	Ladies and gentlemen, it is now time for the main event! This match will determine who is the “undisputed heavyweight sniffer of the world”! This match may not be your typical fight, but it is a battle no less as we compare two network packet sniffers. One network sniffer that is well known and popular among sniffing fans and another network sniffer that is making waves with its snout. 





	This report will concentrate on the relatively new sniffing challenger, Ettercap and will highlight its features and abilities. After a look at Ettercap, the report will then look into the battle of the network sniffers as Ettercap takes on Ethereal in a nose to nose experimentation. The experiment will be comprised of some tests that will evaluate how each sniffer does and how they each report on their performances	
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An Overview of Ettercap


	Ettercap is a very new network sniffer that has been recently developed. Like most networking tool it is developed in an open source environment. Like most networking sniffers, its primary function is to capture networking packets on the data link. How most software sniffers do this is by relying on lower lever interfaces to be able to show you what the network card sees (Carpenter, 2004). While, in essence most sniffers get the same information from the network card interface it is up to the sniffer to be able to interpret the results and to give the user an intuitive view of the traffic on the data link. 





How to Install: 


	Ettercap is recommended for use in a Unix style environment due to the ease of installation and the fact that the program is distributed through its source code unlike binary installations in Microsoft Windows.  Ettercap requires the following libraries. 


- libpcap 0.8.1 or higher.


- libnet  1.1.2.1 or higher.


- libpthread


- zlib





	Some libraries that are highly recommended for simple operation of the program is to install are the following: 


	- ncurses 5.3 or higher. (for text GUI) 


	- GTK+





	To install ettercap, you must be logged in as root. Use the ./configure.sh script so it generates the required makefile and also probes your system for the required libraries. After the probe, use “make” to compile all sources. Then use “make install” to deploy the program onto the system. After installation, use the command “ettercap” to run the program. Alternatively, use “ettercap -C” to run the ncurses GUI or ettercap -G to run the GTK+ GUI. 





Features of Ettercap


	Some of the features that Ettercap can pride itself on include a very easy to use interface. The interface is reminiscent of the MS-DOS years and easily gives the user access to many of the functions within the software. In addition to sniffing, the tables that the software gives (using the GUI interface) include a “live” connection view. Basically, in this scenario the user would be acting like the “man in the middle” listening to every word between the conversation. 





	Another useful feature is a connection list view which shows the user what the active connections that are going on in real time. In this view, a user can see the source and destination IP addresses, source and destination port numbers, the protocols used in the connection as well as the bytes sent between the users. At first, the view may seem boring, but one very unique event that occurs in Ettercap is when a star appears next to one of the rows in the list of connections. This means a username and password was caught while listening to the connection. This is very useful if one wishes to hack accounts. Ettercap can recognize passwords from over 20 different protocols. 





	Other features include bridged sniffing. It allows you take traffic on one side of the cable entering one of the network interfaces and forwards it through and out another network interface allowing you to sniff and filter out content on the fly. According to the documentation, this method of sniffing is fully stealthy. Some other features which are reported by the programmers but not verified are the ability to sniff SSH1 and SSL connections (In SSL's case, a fake certificate is presented to the client), character injection in an established connection, packet filtering and dropping and killing an established connection.  This sniffer is also not without its weapons. With this sniffer a user can generate a variety of attacks that can change the way the network operates such as ARP poisoning, DHCP spoofing, port stealing and more which are supplied either internally or by a plug-in system on Ettercap.





How to use Ettercap


	Using Ettercap in a GUI environment is highly recommended because of the stream of information being update in real time. At the time of the tests, the GTK+ interface was inaccessible. Therefore for simplicity reasons, this report will concentrate on instructions on using Ettercap using the curses GUI interface. 





To get to the Sniffing section:


	- Under the "Sniff Menu" select "Unified Sniffing"


	- Enter in the network interface you wish to use for sniffing traffic (usually the first 	interface on the machine is eth0)


	- Press “ENTER”








To Begin Sniffing:


	- Under the "Start" Menu select "Start Sniffing" 





To Stop Sniffing:


	- Under the "Start Menu" select "Stop Sniffing" 





During Sniffing Operation
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Viewing Connections: 


	- From the "View" Menu select "Connections" or press "C"


	- From there, you may "spy" on a connection just by simply highlighting one of 	the active connections and pressing 


	"ENTER".


(Screenshot on right shows the live connections list)


	


Viewing Statistics:


	- From the "View" menu, select "Statistics" or press "S". 





Setting hosts to target sniffing:


	- From the "Targets" menu select "Select Target(s)"


	- You may specify up to two targets which can represent an IP or an IP Range 	(eg: 10.20.30.40 or 10.20.30.40-50 or 10.20.30.40,50,60-80/22,24, etc...). 


	- To switch between the two groups of targets under the "Targets" menu select 	"Current targets(s)". 


	- Use the right and left arrow keys to switch between groups. 





To activate a plug-in:


	- From the "Plugins" menu, select "Manage the Plugins"


	- A list of available plugins is shown on the screen with a short description on its 	functionality. 


	- Select the plug in and hit "ENTER". 


- The plugin may ask for any additional information if needed. After entering the information, press "ENTER".


	- The plugin will activate and its status is shown in the "User Messages" section.


	- Select the plugin again to deactivate it. 


		


To view a profile of a machine: 


	- Under the “View” menu select “Profiles” or press “O”


	- A list will appear showing the host information Ettercap was able to get. 


	- Select the host and press “ENTER” 


	- A window will appear showing the information of the host Ettercap was able to	acquire.








To scan for hosts on a LAN:


	- Under the “Hosts” menu select “Scan for Hosts”


	- Ettercap will perform a scan seeing which IP’s are taken by hosts in the LAN.





To show the host list on a LAN:


	- Under the “Hosts” menu select “Hosts List” or press “h”


	- A window will appear showing the list of hosts.


	- Note than a host scan is required before performing this function. 





The Battle of the Sniffers: Ettercap Verses Ethereal
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	With this new sniffer entering the network ring, it was decided that an experiment comparing the two would be performed. The experiment would look into how much a sniffer could sniff, what information it could sniff and also rated the additional features. One difficulty in testing the effectiveness of the sniffers was the networking setup.  


(Picture on right shows a screenshot of the Network Analyzer: Ethereal)
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The Equipment and Environment


	All tests were performed on Fedora Core 2 (with Linux Kernel version: 2.4x) under an Intel Pentium 3 machine. Ethereal 0.10 and Ettercap 0.7.1NR were used on the same computer. Unfortunately, the experiment was not performed in the best environment. Because of the networking hardware security features and resources available, the network sniffers could only sniff TCP packets from the same computer they were configured upon. As a result, it made it difficult to effectively test all of the features of both sniffers. Therefore, the scope of the results would only look at TCP packets from the testing computer.  





The Experiment: Sniffing (Three trials)


	The first experiment looked at what the sniffers did while sniffing and what information it was able to get from the sniffing. The sniffers sniffed a connection a web site using HTTP, a secure connection to Kaleem’s bank account on HTTPS and an FTP connection to Kaleem’s company's official web site.  Mozilla was used as the client for both HTTP and HTTPS and linux’s FTP command was used to run transactions in the FTP connections. 





Ethereal:


	During the actual sniff, the sniffer only gave information about what kind of packets were sniffed. But after the sniffing, Ethereal gave very thorough information about what was contained in each packet. The sniffer had to stop sniffing before information could be given. 





	In the trial that looked at an unsecured HTTP connection, to kmaxmedia.com (Kaleem’s web site), Ethereal gave all precise details of every packet that passed by during the transaction including packets that were setup. This was from the beginning of setting up the connection, to sending the HTTP request and receiving the HTTP response and data. Each packet Ethereal captured gave all of the details, especially what was in the TCP and IP headers. 





	The next trial looked at a connection to the on-line CIBC banking service which used encryption. As expected, Ethereal had a slim chance to get any known text that could be understood, but it was able to recognize the public key from CIBC. Of course with the common practice of asymmetric keys, the public key is no use to the attacker since the public key cannot decrypt the ciphertext. 





	The final trial looked at a login to Kaleem’s official website using FTP and Ethereal once again showed its strength capturing the login sequence and sniffing up the login and password of his web site. Of course, we will not disclose that information in this report. It also was able to see all of the commands and responses from the FTP server. 





�
Ettercap:





	With the strong performance from Ethereal, the new sniffer had a good challenge but was well up to match the challenge. In the HTTP trial, it successfully was able to sniff a connection to Kaleem’s official web site, kmaxmedia.com showing the full sequence of the connection. However, Ettercap would only capture the payload rather than including the TCP and UDP headers. What was especially noticed was that Ettercap would throw away some of the payload or not show it on the screen. It was unclear if Ettercap was caching the information and erasing it or if limited the amount of data that was captured.  Whatever it was, in some cases, didn’t show the full information. But, it did show the full sequence of that particular connection





	With the HTTPS connection to Kaleem’s bank account information it was the same result. The encryption provided an effective way to protect against people sniffing networks. Ettercap was not in a good position to use its man in the middle attack for HTTPS, so it could only watch and sniff as it was only able to capture the ciphertext. 





	With FTP, to Kaleem’s official web site, Ettercap was not only able to sniff the login information, but also, notified the user of a password capture which showed up as a star symbol next to the connection it was sniffing. The information also showed in the user messages section. 
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The Comparison: What to expect while sniffing and some observations. 





	During the sniffing sequence, Ethereal would only disclose information about the certain types of packets that it was able to sniff up. This was probably due to the fact that it would be tough for the user to keep up with the detail of the packets in. In Ettercap, this was a completely different story. As Ettercap sniffed, not only did its statistics updated in real time, but it also was able to keep track of what connections were active, what protocol they used and most of all, you can listen in as someone talked on the connection which could be very important in finding out things. As mentioned before, anything that related to passwords and username, Ettercap would automatically inform the user that such input was sent over a particular data link. Putting this information in a separate text window makes it much easier for the user to record valuable data.





Extra Features:


	Ethereal’s handing on packet information was very thorough and it will give you everything you need with respect to the individual packets and their payloads. Also, its broad support for protocols and filtering features allows the user to better manage that information. Ethereal can also read capture logs from over 20 other programs and formats. 





	As for Ettercap, in addition to its sniffing features, this suite is an almost dream to people who want to experiment with the technologies on the network. Not only does Ettercap have features that allow you to test the security of your network, but it also has an add-on plug-in system that allows you to create customized functions to be used within Ettercap. An example of this is the Denial of Service (DoS) plug in that allows you to attack an IP and prevent clients from accessing a host. With its GUI interface, Ettercap’s very powerful functions become easy to use without having to learn the command line parameters and suffer from linear output. (Ettercap uses nothing but printf to output in command line mode). The only big concern was the storage of live connection data and how soon it decided to get rid of it. The best way to overcome this was to use the log but, when attempts to use this feature failed. Possible causes might have been the system environment but it was unclear.  





The Verdict:





	Ethereal is very strong to giving a user full information on every single packet that passes the network interface. This was the main purpose of the program. While you can read every single packet to get information manually, its purpose was very specific and focused on analyzing packets. 





	Ettercap on the other hand was made to give the user information about what is being communicated on the wire. It does not focus on the information on the packets themselves. Ettercap would be under the assumption that users possesses the knowledge of network packet formats to be able to understand what is going on when Ettercap performs its sniffing. With that said, the program is then free to incorporate features that allow the user much more power in manipulating the network and viewing information about its host. 





	In essence, users who want to analyze packets and the information contained in each packet along with support for a wide variety of protocols would be best served by using Ethereal. Users that wish to take their digital security systems on the network to the edge would just love Ettercap for its ability to sniff and inject information on the network. 





The Final thoughts: Pros and Cons


Pros:


	Ettercap is very powerful in which it allows the user to not only sniff data but also inject data and manipulate hosts to be able to establish  man in the middle attack situations. Its easy to use GUI interfaces will make it very easy for a person who understands networking to test the security of his or her network. Probably the most enjoyable feature is the sniffing feature which shows you the action in real time as it is happening. This feature is especially highlighted in its live communication view of a connection. 





Cons:


	This software is distributed in source code. It may be simple to install this in a Unix style environment, but it’s a completely different story in Windows since you will have to figure out how to compile it. With no Windows platform documentation, users will have a hard time with this program.  The “curses GUI” was also not well thought out. When you bring in views, new text windows only open and there is no way to close them. Basically, each view that comes up overlaps the other and to get it back, the user would have to use the shortcut key which calls up the view. Sometimes the view would obstruct some of the text of another. This program may be powerful, but it still has a ways to go in its Text GUI, usability and documentation.





Conclusion


	With the dust settling in the battle of the sniffers, the new Ettercap proved to be a worthy foe against Ethereal possessing immense manipulating power which can easily change a network’s environment. However, being the new program on the block means that it still needs time to develop itself into a robust, dependable and a mature tool like Ethereal. 
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